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1. Introduction

Functional programming languages

e subset of declarative programming languages: computation
is defined by set of declarations

e type, class, function definitions, initial expression

e computation means evaluation of the initial expression (rewriting
rules)

e mathematical model of computation: MA-calculus (Church,
1932-33, computationally equivalent to Turing machine)



Functional programming style

e specification of problem, refinement of problem are the main
concerns

e program components solving subproblems do not cause side-
effects

e specification by pre- and postconditions, function compositions
given in postcondition correspond to the structure of solution



Evaluation

e evaluation = sequence of rewriting (reduction) steps

e example for a function definition:
Sqr x = X * X
function identifier, formal argument, function body (expression)

e aspects: computability, effectiveness

e Reduction step: substitution (rewriting) of a function application
by its definition in the body, until we reach normal form.

e Evaluation strategy: selection order of redexes (reducible
expressions), well-known strategies: lazy (function application
first), eager or strict (arguments first), parallel.

e Normal form is unique (in confluent rewriting systems), Lazy
evaluation order always finds the normal form, if it exists.



Examples

inc x = x+1

square X = X*X

squareinc x = square (inc x)
fact n = product [1..n]

fact 10
squareinc 7

strict:
squareinc 7 -> square (inc 7) -> square (7+1)
-> square 8 -> 8x8 -> 64
lazy:
squareinc 7 -> square (inc 7) -> (inc 7) * (inc 7)
-> 8 * (inc 7) -> 8%8 -> 64



Characterization of modern purely functional languages

e NO destructive assignments

e referential transparency - equational reasoning (same expression
means always the same value)

e strongly typed (every subexpression has a static type), type
deduction, polymorphism, abstract algebraic data types

e higher order functions (argument or value is a function)
twice £ x = £ (f )\

e Currying - functions with 1 argument
(+) xy vs. (((+) x) ¥).
e recursion

e lazy evaluation and strictness analysis £ x = 0; £ (5+1); 2
x (b+1)
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Zermelo-Fraenkel set-expressions
{ x*x \\ x <- [1..] | odd(x) }

pattern matching of arguments
fac 0 = 1
facn | n >0 =n x fac (n-1)

off-side rule determining scope of identifiers
add4 = twice succ
where
succ x = x+2

add = ... succ

I/O models: i/o stream, monads, unique world



Small Clean programs

module test

import StdEnv

Start =
// 5 + 2x%3
// reverse (sort [1,6,2,7])
// 2 <1 || 3<4
// and [True, 2<1, 6>5 ]
map my_abs2 [7,-4,3]
my_abs x
| x < 0 = "x
| x >= 0 = x
my_abs2 x
| x < 0= "x

otherwise = x

//
//
//
//

sum [1..10]

1 <2 && 3 < 4
[1,2] ++ [3,4,5]
take 3 [1,2,3,4,5]



Quadratic equation

module quadratic

import StdEnv

e e N
qeq :: Real Real Real -> (String,[ReaEi)
geq a b c

| a == 0.0 = ("not quadratic",[])
| delta < 0.0 = ("complex roots",[])
| delta == 0.0 = ("one root",["b/2.0%*a])
| delta > 0.0 = ("two roots", [("b+radix)/(2.0xa),
("b-radix)/(2.0*a)])
where
delta = b*b-4.0*ax*xc
radix = sqrt delta

Start = qeq 1.0 (-4.0) 1.0
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Queens

module queens
import StdEnv

<

[[1]
queens n = [ [q:b] \\ b <- queens (n-1),

q <- [0..7] | safe q b ]

queens O

safe q b = and [not (checks q b i)
\\ i <- [0 .. (length b)-1] ]

checks q b i = (q == b!!i) || (abs(g-b!!i)==(i+1))

Start = (length(queens 8),queens 8)
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Simple 10 on console

module helloconsole

import StdEnv
Start :: *World -> *World

Start w

# (console,w) = stdio w
console = fwrites "enter your name:\n" console
(name,console) = freadline console
console = fwrites ("Hello " +++ name) console
(_,console) = freadline console
(ok, nw) = fclose console w

| not ok = abort "error"

| otherwise = nw



Test environment

module functiontest

import funtest, StdClass, StdEnv

Start :: *World -> *World

Start w = functionTest funs w

dubl :: Int -> Int

dubl x = x * 2

plus :: Int Int -> Int

plus x y = x+y

f1 :: [[Int]] -> [Intl]

fl a = flatten a

funs :: [(([String] -> String), [String],String)]

funs = [ (one_arg dubl, ["2"] , "dubl"),
(two_arg plus, ["2","10"] , "plus"),
(no_arg "Hello world", [], "Program"),
(one_arg f1, ["[[1,2,3,4]1,[1,[411"],"flatten")]



2. Simple Elements of Clean

Pattern matching

hd [x:y] = x // partial
tl [x:y] =y // partial

fac
fac

Sum
Sum

0=1

n

| n > 0 =n * fac (n-1) // partial
[J =0

[x:xs] = x + sum xs

length [] =0
length [_:rest] = 1 + length rest



Type checking

1 + True // Type error: "argument 2 of +" cannot unify
// demanded type Int with Bool

length 3 // "argument 1 of length" cannot unify
// demanded type (a b) | length a with Int

Type definitions, annotations
// Elementary types: Int, Real, Bool, Char
// Types identifiers starts by uppercase letters

Start :: Int x:: [Int] y::[Bool]
Start = 3+4 x=[1,2,3] y=[True,True,False]
z::[[Int]] sum: : [Int]->Int

z= [[1,2,3],[1,2]] sqrt:: Real->Real



Annotations

Annotations in type definitions (!, *, etc.) may specify strict
evaluation of arguments or a unique reference to the argument.

Polymorphic type

Type containing type variables,
functions with polymorphic types are called polymorphic functions.

length :: [a] -> Int // a is a type variable,
hd ;1 [a]l -> a // id started by lower letter

The functionality of the polymorphic function is not depending
on the actual type.



Overloading, ”"ad hoc polymorphism”, classes

There are many instances of +, the functionality of + is depending

on the type. The signature is the same.
(+) :: aa->a // illustration
Classes declare overloaded identifiers having the same signature.

class (+) infixl 6 a :: 'a 'a -> a // abstract (+) function

// with strict evaluation
double :: aa -> a | + a // if (+) has an instance
double n :== n + n // then double too

Instance definition by systematic substitution:
instance + Bool

where

(+) :: Bool Bool -> Bool // instance
(+) True b = True

(+) a b=">



Synonyms

e Global constants, evaluated once (run-time), reusable.
Optimization: execution time decreased vs. memory usage
increased.

smallodds =: [1,3 .. 10000]

e Type synonyms (replaced in compile time)

:: Color :== Int // Color is the same type as integer

e Macros, synonyms of expressions (replaced in compile time)

Black :== 1 White :== 0



Higher order functions on lists

o filter - selecting elements satisfying a property
filter :: (a -> Bool) [a] -> [a]

filter p [] = []
filter p [x:xs]
| p x = [ x : filter p xsl
| otherwise = filter p xs
even X = X mod 2 ==
odd = not o even // odd x = not (even x)
evens = filter even [0 .. ]

e map - function applied elementwise (length is preserved)
map :: (a -> b) [a] -> [b]
map f [] =[]
map f [x:xs] = [ £f x : map f xs]
odds = map inc evens



e foldr - elementwise consumer

foldr :: (.a-> .(.b-> .b)) .vp!l.a] => .b

// foldr :: ( a a-> a) a [a] -> a
foldr op e [] = e

foldr op e [x:xs] = op x (foldr op e xs)

sum = foldr (+) O // sum xs = foldr (+) O xs

and = foldr (&&) True

e takeWhile - takes while p, dropWhile - drops while p

takeWhile p [] = []
takeWhile p [x:xs]
| p x = [ x : takeWhile p xs ]

[]

| otherwise



Iteration

Iteration of £ while not p:
until :: (a -> Bool) (a -> a) a -> a
until p f x
| p x = x
| otherwise = until p £ (£ x)
power0fTwo = until ((<) 1000) ((x) 2) 1 // 1024

Example - square root by Newton iteration
sqrtn :: Real Real -> Real
sqrtn x = until goodEnough improve 1.0
where
improve y = 0.5 * (y+x/y)
goodEnough y = (y * y) "= x
("=") a b = abs(a-b) < 0.00001



3. Lists

[1,2,3%x,length[1,2]] :: [Int] // enumeration of the elements
[sin, cos, tanl] :: [Real->Real]

[] 1 oa

[3<4,a==5,p&&q] :: [Bool]

[1,3..12] [100,80,..] // arithmetical sequences

Representation of list: xs=[1,2,3].
Spine and elements. Extending the list by an element.

[0:)%

XS 1 2 3




Standard functions on lists

tl

L —

hdl —> 1 2 3 <— lastl

init] — [

hd [a:x] = a

hd [] = abort "hd of []"
last [a] = a

last [a:tl] = last tl

last [] = abort "last of []"

tl [a:x] = x

tl [] = abort "tl of []"

init [] = []
init [x] =

init [x:xs]

[]

[x:

init xs]



drop 21

L —> []
1 2 3E— 112
take 2 |
R %
(1) infixl 9 :: [a] Int -> a
(1) [ _ = subscript_error

(!!) 1list i = index list i
where index [hd:tl] O
index [hd:tl] n

hd
index t1 (n - 1)

index [] = subscript_error
take 0 _ = []
take n [a:x] = [a:take (dec n) x]
take n [] = []



drop n cons=:[a:x]
| n>0 = drop (n-1) x
= cons
drop n []1 = []
(%) 1list (frm,to) = take (to - frm + 1) (drop frm list)

reverse list = reverse_ list []

where reverse_ [hd:tl] list = reverse_ tl [hd:1list]
reverse_ [] list = list

L — []
1 2 3

reverse|




(++) infixr 5 :: [a]l] [a]l -> [al
(++) [hd:t1l] 1list = [hd:tl ++ list]
(++) nil list = list

length xs = acclen 0 xs

where

acclen n [x:xs] acclen (inc n) xs

acclen n [] =n

isMember x [hd:tl] = hd==x || isMember x tl

isMember x [] = False

flatten [h:t] h ++ flatten t
flatten [] = []



instance == [a] | Eq a

where
(==) [1 [ = True
(==) [ _ = False

(==) [L:_]1 [l = False

(==) [a:as] [b:bs]

| a ==D
instance < [a] | Ord a
where
(<) L[] [] =
(<) [ _ =
(<) [_:_1 [1 =
(<) [a:as] [b:bs]
| a < b =
| a > b =

]
rq
)
|_l
%)
)

False
True
False

True
False
as < bs



repeat x = cons
where cons = [x:cons]
// repeat 3 is [3,3..]

iterate f x = [x:iterate f (f x)]
// iterate inc 3 is [3,4,..]
removeAt 0 [y : ys] = ys
removeAt n [y : ys] = [y : removeAt (n-1) ysl
removeAt n [] = []



Sorting by insertion

Insert :: a [a] -> [a] | Ord a
Insert e []1 = [e]

Insert e [x:xs]

| e<=x = [e,x:xs]
| otherwise = [x: Insert e xs]
isort :: [a] -> [a]l | Ord a

isort [] = []

isort [a:x] = Insert a (isort x)



Sorting

Merge []
Merge xs
Merge [x
| x <=

| othe
msort ::
msort xs
| len

| othe

where

ys =

zs =
half

len

by merging

ysS = ys

[1 = xs

:xs] [y:ysl

y = [x: merge xs [y:ys]]
rwise = [y: merge [x:xs] ys]

[a] -> [a] | Ord a

<=1 = XS
rwise = Merge (msort ys) (msort zs)

take half xs
drop half xs
= len/2

= length xs



Quicksort / List comprehensions

gsort :: [a] -> [a] | Ord a
gsort [] = []
gsort [a:xs] = gsort [x \\ x <- xs | x < a] ++ [a]
++ gsort [x \\ x <-xs | x > a]
sieve [p:xs] = [p: sieve [ i \\ 1 <- xs | i mod p <> 0]]
// take 100 (sieve [2..])

Orthogonal generators:
[(x,y) \\ x <= [1..4], y <= [1..x] | isEven x ] is
[(2,1),(2,2),(4,1),(4,2),(4,3),(4,4)]

LLast varies fastest, variable of inner generator is not allowed to
use in generators preceding it.

Parallel generators:
[ (X,Y) \\ X <- [1..2] & y <- [4--6]] iS [(1’4)’(2’5)]



4. Tuples and records

— T2

a 7

fst snd
fst (x,_) = x snd (_,y) =y
splitAt O XS = ([],xs)
splitAt _ L] = (1,01
splitAt n [x:xs] = ([x:xs‘],xs¢“)

where (xs‘,xs‘‘) = splitAt (n-1) xs
zip2 [a:as] [b:bs] = [(a,b):zip2 as bs]
zip2 as bs = []



average list = s / toReal 1
where
(s,1) = sumlength list 0.0 O

sumlength [x:xs] sum 1

sumlength xs (sum+x) (1+1)

sumlength [] sum 1 = (sum,1)
search [] s = abort "none"
search [(x,y):ts] s

| x==s =1y

| otherwise = search ts s
book = [(1,’a’),(2,’b?),(3,’c?)]
// search book 1



Records

+: Point = { x

> ¥
, visible
}
:: Vector = { dx
,» dy
+
Origo :: Point
Origo = { x = 0.0
, y = 0.0

, visible = True

}

Real
Real
Bool

Real
Real



Pattern matching on selectors

IsVisible :: Point -> Bool

IsVisible {visible = True} = True
IsVisible _ = False
xcoordinate :: Point -> Real

xcoordinate p = p.x

hide :: Point -> Point
hide p = { p & visible = False }

Move :: Point Vector -> Point
Move pv={p&x=p.x+v.dx, y=p.y+v.dy}



Rational numbers

:: Q = { nom :: Int
, den :: Int
}

1, den

QZero = { nom = 0, den =1 } QO0ne = { nom

simplify {nom=n,den=d}

| d == 0 = abort " denominator is 0"

| d <0 = { nom = "n/g, den = “d/g}

| otherwise = { nom = n/g, den = d/g}
where g = gcd n d
gcd x y = gcdnat (abs x) (abs y)

where gcdnat x 0 = x

gcdnat x y = gcdnat y (x mod y)

mkQ n d = simplify { nom = n, den = d }



instance x*
where (*) b = mkQ (a.nom*xb.nom) (a.den*b.den)

instance /

where (/) mkQ (a.nom*b.den) (a.den*b.nom)

instance +

where (+) b = mkQ (a.nom*b.den+b.nom*a.den) (a.den*b.den)
instance -

O p o p o P e
o
I

where (=) a b = mkQ (a.nom*b.den-b.nom*a.den) (a.den*b.den)
instance toString Q
where

toString q = toString sq.nom +++ "/" +++ toString sq.den

where sq = simplify q



Arrays

Array5 :: *{Int}
Array5 = {3,5,1,4,2}

—>1 Array5

Unboxed :: {#Int}
Unboxed = {3,2,7,4,2}

——= Unboxed 3 2 7




Operations on arrays
Selection:
Array5.[1]+Unboxed. [0]
Array comprehensions:

narray = { e \\ e <- [1,2,3] }
nlist = [ e \\ e <-: Array5b |

Unique arrays:

mArray5 = { Arrayb5 & [3]1=3, [4]=4 }
{ Array5 & [il=k \\ i <- [0

mArray

..4] & k <-[80,70..]1}



5. Algebraic types

Trees (unary type constructor):

:: Tree a = Node a (Tree a) (Tree a)
| Leaf
atree = Node 2 (Node 1 Leaf Leaf) (Node 3 Leaf Leaf)

2

Node

Node / Node /

L eaf Leaf L eaf Leaf




Pattern matching - data constructors

depth :: (Tree a) -> Int

depth (Node _ 1 r) = (max (depth 1) (depth r)) +1
depth Leaf = 0

MayBe - extension of type value set

MayBe a = Just a | Nothing

Enumeration type
(nullary type constructor, nullary data constructors):

:: Day = Mon | Tue | Wed | Thu | Fri | Sat | Sun



Abstract data types

definition module stack

:: Stack a

Push :: a (Stack a) -> Stack a
Pop :: (Stack a) -> Stack a
top :: (Stack a) -> a

Empty :: Stack a

implementation module stack

:: Stack a :== [al]

Push :: a (Stack a) -> Stack a Push e s = [e:s]
Pop :: (Stack a) -> Stack a Pop [e:s] = s
top :: (Stack a) -> a top [e:s] = e
Empty :: Stack a Empty = []

Start = top (Push 1 Empty)



Classes

Classes define signatures of a set of abstract (higher order)
functions.

class PlusMin a // class variable

where (+) infixl 6 :: l!a !'a -> a
(-) infixl 6 :: 'a la -> a
Zero T a

The type of the instance functions is produced by systematic
substitution:

instance PlusMin Char

where (+) :: !Char !Char -> Char
(+) x y = toChar (toInt(x) + toInt(y))
(-) x y = toChar (toInt(x) - toInt(y)) // negative?
zero = toChar O



Instantiation is not allowed for type synonyms.

There are derived functions:

double :: a -> a | + a

double n :== n+n
New classes for set of overloaded functions (singleton classes):

import StdClass
class Discriminant a | *, -, fromInt a
discriminant :: a a a -> a | Discriminant a // not a class

discriminant a b ¢ = bxb - 4x*xaxc



Insolvable internal overloading:

Start = toString (zero + zero)
Start = toString sum
where sum :: Q // additional information needed

sum = zero + zero

Default instance:

instance zero (Q default
where zero = mk(Q O 1
instance one Q default

where one = mkQ 1 1



Generators are derived from instances of

class Enum a | <,+,-,zero,one a:

instance < Q
where (<) x y = sx.nom * sy.den < sx.den * sy.nom
where (sx,sy) = (simplify x, simplify y)
Start = [ toString q \\ q <- [zero, mkQ 1 3 .. mkQ 3 2]]

Derived class members: instances never defined, but inherited.



Ordering and equality - derived class members:

class Eq a | == a

where
(<>) infix 4 :: 'a 'la -> Bool | Eq a
(<>) x y :== not (x == y)

class Ord a | < a

where
(>) infix 4 :: 'a !'a -> Bool | Ord a
>) xy :==y<x
(<=) infix 4 :: 'a 'a -> Bool | Ord a
(<=) x y :== not (y<x)
(>=) infix 4 :: 'a 'a -> Bool | Ord a
(>=) x y :== not (x<y)
min :: 'a 'a -> a | Ord a
min x y :== if (x<y) x ¥y
max :: 'a 'a -> a | Ord a

max x y :== if (x<y) y x



Higher order types, type constructor classes

Set of higher order classes as instances of the same abstract
signature. Examples:

map :: (a->b) [a] -> [b]

map f xs [a:as] = [f a:map f as]
:: Tree a = Node a [Tree a] map £ [] = []
mapTree :: (a->b) (Tree a) -> Tree b

mapTree f (Node el 1s) = Node (f el) (map (MapTree f) 1s)

Common abstract signature, classvariable t is defined over higher
order types (type constructors):
class map t :: (a->b) (t a) -> (t b)
instance map []
where map £ 1 = [ £ e \\ e <-1]
instance map Tree
where map f (Node el 1s) = Node (f el) (map (map f) 1s)



Union and existential types

Union of two types:

:: OneOf ab=Aa | Bb

:: List_of_Int_or_Char :== [OneOf Int Char]
[(B ’a’),(A ’5’),(B ’c’)]

List of union of all existing types:
:: List = E.a : Cons a List | Nil
eList = Cons ’a’ (Cons ’5’ (Cons ’c’ Nil))
Hd (Cons hd tl) = hd // type error
Tl (Cons hd tl) = tl
elist = [ Cons ’a’, Cons ’5’, Cons ’c’] // [] : hd tl
Start = (hd elist, Tl elList)
// ((Cons ’a’),(Cons ’5° (Cons ’c’ Nil)))

Hd : EXxistentional type variable is not allowed to appear in result
type.



Composition of sequence of functions

seq :: [t->t] t > ¢t

seq []

S = S

seq [f:fs] s = seq fs (f s)

:: Pipe a b = Direct ( a->b )

ApplyPipe ::

ApplyPipe
ApplyPipe
ApplyPipe

| E.via : Indirect ( a->via ) (Pipe via b)
(Pipe a b) a > b
(Direct f) x = f x
(Indirect f pipe) x = ApplyPipe pipe (f x)
(Indirect toReal (Indirect exp (Direct tolnt))) 7



Using existential types

:: Point :== (!Int,!Int)

:: Line :== (!'Point, !'Point)

:: Rectangle :== (!Point,!Point)

Oval :== Rectangle
: Curve :== (!0Oval,!Int,!Int)

:: Drawable = E.a : { state :: a
, move :: Point -> a -> a
, draw :: a Picture -> Picture
}

MakelLine :: Line -> Drawable

MakelLine line
= { state = line
, move = \dist line -> line + (dist,dist)

, draw = DrawLine }



MakeCurve :: Curve -> Drawable
MakeCurve curve
= { state = curve
, move = \dist (rect,al,a2) -> (rect + (dist,dist),al,a2)
, draw = DrawCurve
}
MakeRectangle :: Rectangle -> Drawable
MakeRectangle ((x1,y1),(x2,y2))
= { state
= [ MakeLine ((x1,y1),(x1,y2)), MakeLine((x1l,y2),(x2,y2))
, MakeLine ((x2,y2),(x2,y1)), MakeLine((x2,y1),(x1,y1))]

, draw = \s p —>
foldl (\pict {state,draw} -> draw state pict) p s
, move = \d -> map (MoveDrawable d)
+
MoveDrawable :: Point Drawable -> Drawable

MoveDrawable p d =: {state,move} = {d & state = move p state}



:: AlgDrawable
= Line Line
| Curve Curve
| Rect [Line]
| Wedge [AlgDrawable]
move :: Point AlgDrawable
move p object
= case object of
Line line ->
Curve (rect,al,a2) ->
Rect lines ->
Wedge parts ->

-> AlgDrawable

Line (line + (p,p))

Curve (rect + (p,p),al,a2)

Rect [line + (p,p) \\ line <- lines]
Wedge (map (move p) parts)



Uniqueness types

Destructive updates preserving referential transparency. Update
of an argument (of files, windows, etc.) is allowed if there is
just a single reference to the argument at evaluation time.

e Uniqueness is a function property (just a single reference to
the argument and/or to the value).

e T he type system derives the uniqueness properties of all
functions.

e It is possible to reuse unique argument components instead
of rebuilding them.



Uniqueness propety may be lost, if the result is multiply referenced.

duplicate :: *a -> (*a,*a) // wrong

duplicate x =(x,x) // result is not unique

Uniqueness propagation (outwards):

head :: [*xa] -> *xa // spine unique

Uniqueness polymorphism: u < x < u = .

id :: uta -> u:a

class (++) infixr 5 a :: v:[u:al] w:[u:al] -> x:[u:a]l,
[v w x<=u , w<=x]

class (++) infixr 5 a :: v:[.a] w:[.al -> x:[.al], [w<=x]

// equvivalent



I/O in Clean

e I/O in Clean uses the world as value paradigm,

e environments (external resources, file system, event stream)
are passed explicitly as a value to functions,

e I/O programs are functions of type unique :: *World ->
*World.

Environment passing:

fwritec :: Char *File -> *xFile
AppendAB :: *File -> x*File
AppendAB file = fileAB
where fileA = fwritec ’a’ file
fileAB = fwritec ’b’ fileA



Start w = CopyFilelnWorld w
CopyFileInWorld :: *World -> *World
CopyFileInWorld w = appFiles (CopyFile infn opfn) w
where

infn = "source.txt"

opfn = "copy.txt"
CopyFile :: String String *Files ->*Files
CopyFile infn opfn filesys

| readok && writeok && closeok = finalfilesystem

| not readok = abort '"read error"

| not writeok = abort "write error"

| not closeok = abort '"close error"
where

(readok,inf,touchfilesys) = sfopen infn FReadText filesys
(writeok,outf,nwfilesys) = fopen opfn FWriteText touchfilesys
copiedfile = LineFileCopy inf outf

(closeok,finalfilesystem) = fclose copiedfile nwfilesys



LineFileCopy :: File *File -> *File

LineFileCopy inf outf = LineListWrite (LineListRead inf) outf
LineListRead :: File -> *[String]

LinelListRead f

| sfend f = []
| otherwise = [line:LinelListRead filerest]
where

(line,filerest) = sfreadline f
LineListWrite :: [String] *File -> *File
LineListWrite [] £ = f
LineListWrite [l:1lines] f = LinelListWrite lines (fwrites 1 f)

Start w = CopyFileInWorld w



6. Interactive Clean processes

Object I/O: unique state space, initialization and state-
transition functions,

interactive processes created and closed dynamically

interactive objects: windows, dialogues, menus, timers, and
receivers created and closed dynamically,

interactive process implement state transition systems,

state: PSt 1 p = {1s :: 1, ps :: p, io :: =*I0St 1 p}, logical
state, public state, I/O state, additional locale state

logical state and local state is defined by the programmer

io state: the external environment, the current state of all
interactive objects of the interactive process.



Interactive Objects

e Objects are defined by algebraic data type values containing
the state transitions of the interactive process

e state transitions are higher order function arguments of the
algebraic data types having the type:
(PSt .1 .p) —> (PSt .1 .p),

e event handlers of I/O processes on the same processor are
interleaved, atomic actions correspond to handling of one
event,

e Object I/O system keeps evaluating all interactive processes
until each of them has terminated,

e closeProcess : closes all current interactive objects from
the IO state component and turn it into the final empty IO
state.



module hellooio

import StdEnv, StdIO
Start :: *World -> *World
Start world

= startI0 NDI Void (snd o openDialog undef hello) [] world
where

hello = Dialog "" (TextControl "Hello world!" [])

[WindowClose (noLS closeProcess)]



module hellowin
import StdIO0, StdEnv
: ¢ NoState = NoState
Start :: *xWorld -> *World
Start w
= startI0 MDI O (openwindow o openmenu) [] w
where
openwindow = snd o (openWindow NoState window)
window = Window "Hello window" NilLS
[ WindowKeyboard filterKey Able quitFunction,
WindowMouse filterMouse Able quitFunction,
WindowClose quit,
WindowViewDomain {cornerl=zero,corner2={x=160,y=100}},

WindowLook True look



openmenu = snd o (openMenu NoState file)
file = Menu "File"
( MenuItem "Quit" [MenuShortKey ’Q’
,MenuFunction quit]) []

quitFunction _ ps = quit ps

quit (1s,ps) (1s,closeProcess ps)
look _ _ = drawAt {x=30,y=30} "Hello World"
filterKey key

= getKeyboardStateKeyState key <> KeyUp
filterMouse mouse

= getMouseStateButtonState mouse==ButtonDown



definition module funtest
from StdString import String
import StdEnv, StdI0, conversion
functionTest :: [(([String]->String), [String],String)]
*World -> *World
no_arg :: y [String] -> String | toS y
one_arg :: (x->y) [String] -> String
| fromS x & toS y
two_arg :: (x y -> z) [String] -> String
| fromS x & fromS y & toS z
three_arg :: (x y z -> w) [String] -> String
| fromS x & fromS y & fromS z & toS w



implementation module funtest

import StdEnv,StdI0,conversion

functionTest :: [(([String] -> String), [String],String)]
*World -> *World
functionTest [] w = w
functionTest funs w
# (ids,w) = (openlds (length funs)) w
= startI0 MDI O (initialIO funs ids) [] w
initiallI0 funs dialoglds = openfunmenu o openfilemenu
where
openfilemenu = snd o openMenu undef filemenu
where filemenu = Menu "File"
( Menultem "Quit" [MenuShortKey ’Q’,
MenuFunction quit]) []



openfunmenu = snd o openMenu undef funmenu
where
funmenu = Menu "Functions"
(ListLS
[ Menultem fname [(MenuFunction (noLS opentest))
(if (c<=’9’) [MenuShortKey c] []1) ]
\\ (_,_,fname) <- funs
& opentest <- opentests
& ¢ <- [’1°..]
1) [
opentests =
[ functiondialog id fun
\\ fun <- funs & id <- dialogIds ]



functiondialog ::
Id (([String]->String), [String],String) (PSt

-> (PSt .1 )

functiondialog dlgIld (fun,initvals,name) ps

#

(arglds, ps) = accPI0 (openlds arity) ps
(resultId, ps) = accPI0 openld ps
(evalld, ps) = accPI0 openld ps
snd (openDialog O
(dialog arglds resultld evalld) ps)

where

nrlines = 2

width = PixelWidth 100

arity = length initvals

.1)



eval id arglds resultId fun (1s,ps)
# (Just wstate,ps) = accPI0 (getWindow id) ps
input = [fromJust arg \\ (_,arg)
<- getControlTexts arglds wstate]
= (1s, appPI0 (setControlTexts
[(resultId, fun input)]) ps)
dialog arglds resultld evalld
= Dialog name
( ListLS
[ TextControl ("arg "+++toString n)
[ControlPos (Left,zero)]
:+: EditControl val width nrlines
[ Controlld (argIds!!n)]
\\ val <- initvals & n <- [0..]
]

:+: TextControl "result" [ControlPos (Left,zero)]



:+: EditControl "" width nrlines
[ Controlld resultId]
:+: ButtonControl "Close"
[ ControlFunction (close dlgId) ]
:+: ButtonControl "Quit"
[ ControlFunction quit ]
:+: ButtonControl "Eval"
[ Controlld evalld,
ControlFunction
(eval dlgld arglds resultId fun) ]

)
[ WindowId dlgId, WindowOk evalld ]



close :: Id (.1s,PSt .1 ) -> (.1s,PSt .1 )

close id (1s,ps) = (1s, closeWindow id ps)

quit :: (.1ls,PSt .1 ) -> (.1ls, PSt .1 )

quit (1s,ps) = (1s, closeProcess ps)

no_arg :: y [String] -> String | toS y

no_arg £ [] = toS £

no_arg £ 1 = "This function should have no arguments instead of "
+++toString (length 1)

one_arg :: (x -> y) [String] -> String | fromS x & toS y
one_arg f [x] = toS (f (fromS x))
one_arg f 1 = "This function should have one arguments instead of

+++toString (length 1)
two_arg :: (x y -> z) [String] -> String
| fromS x & fromS y & toS z
two_arg £ [x,y] = toS (f (fromS x) (fromS y))



7. Increase effeciency

e strict arguments, if possible

e accumulating (instead of naive recursive calls):

1fib n = accfibn 1 1
where accfib :: !Int !Int !Int -> !Int
accfib 0 x y = x

accfib n x y = accfib (dec n) y (x+y)



left recursion instead of right recursion:

Length [a:x] = 1 + Length x
length 1 = acclen 0 1

acclen n [a:x] = acclen (inc n) x

inversion, omitting intermediate data structures

abstract data types encapsulate implementatation details,
use arrays instead of lists

avoid Curried functions at critical points
use macros (less rewriting in run time)

use special versions of funtions (inc)



8. Installation of Clean for Windows

. unzip Clean133 and ObjectlO_1.2.1 by Winzip to D:Cleanl133,
subdirectories Clean 1.3.3 and Object IO 121 are created
(CleanIDE included).

. move all subdirectories (StdLib 1.0, ObjectlO 1.2.1 , ObjectlO
Examples 1.2.1) of Object IO 121 to Clean 1.3.3.

. run change_registry.exe

. start CleanIDE and set environment

append StdLib 1.0, ObjectlO 1.2.1, ObjectlO 1.2.1 OS
Windows

under Environment - Edit Current - Path

. open objectlO Examples hello
new project , save , set main module, bring up to date and
run
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9. Installation of Clean for Linux

. tar xvf Clean131.tar
. cd clean
make

(in subdirectories stdenv and iolib/CleanSystemFiles touch
*.abc, wait 60 seconds, touch *.0)

. .bash_profile: export PATH=%$PATH:..../clean/bin

6. clm hello

. ./a.out



